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Removing noise and spikes with the Profile Editor (G09)
New survey data often contains errors that need to be removed, for example:

• Noise– small high frequency fluctuations in measurements due to extraneous 
factors or small shallow irrelevant data sources.

• Spikes– a single point of noise.
In order to correct these errors and also for general viewing of line data, it is helpful 
to be able to view a profile of the data collected along each line. The Profile Editor 
enables you to do this.

In this guided tour you will examine the profiles of lines of a dataset. You will then 
remove the noise and spikes using a variety of methods. You can examine the results 
in a new grid.

This illustration shows a ‘raw’ data line and the same line with noise and spikes 
removed.

Overview
The Profile Editor is one of the INTREPID editors (Spreadsheet, Flight Path, auto 
clip line, split cruise and Profile).
• It provides a time and line-based view of the data, showing the profiles of 

individual lines one at a time. 
• It can calculate filters (such as Naudy and 4th difference) and display the results.
• You can use this tool to quickly and effectively identify and edit noise.
• It supports vector, tensor and quaternion signal fields as well as the traditional 

scalars
• It is geared to work on a time series, perhaps before the geolocation of your signal 

has been carried out.
• It supports current, next and previous overlays of profiles.
• Profile Editor enables you to:

• Select and change the values of data points using the mouse,

Before noise and spike removal

After noise and spike removal
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• Automatically filter an entire dataset,
• Compare different fields from the same line of the same dataset,
• Perform extensive range checks on the data,
• Look at profiles of full tensor data and search for noise spikes,
• Superimpose profiles of data components before and after noise filtering.

Profile Editing process
This illustration on the first page of this guided tour shows a line profile of magnetic 
data before and after noise and spike removal. The upper profile shows noise at 
regular intervals along the line and two spikes. The lower profile shows the same line 
data with the noise and spikes removed.

Grids produced from data before and after use of Profile Editor
This illustration shows grids produced from magnetic data before and after noise and 
spike removal. The left grid produced from data still containing noise and spikes 
shows many small ‘pin prick’ anomalies due to noise, and several larger steep 
anomalies near the bottom due to spikes. The right hand grid produced from data 
that has had noise and spikes removed does not have these anomalies.

Before noise and spike removal After noise and spike removal
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Context of this guided tour
In the context of your data processing cycle, this tour represents an important 
first or second step in processing a set of newly imported data. You should perform 
this process in conjunction with editing out unwanted sections of flight paths using 
the Flight Path Editor.Location of sample data for Guided Tours

We provide two complete sets of sample datasets, one in INTREPID format and one 
in Geosoft format.  INTREPID works equally well with both formats.  When you want 
to open a dataset, navigate to the directory containing the required data format.

Where install_path is the path of your INTREPID installation, the project 
directories for the Guided Tours sample data are   
install_path\sample_data\guided_tours\intrepid_datasets and  
install_path\sample_data\guided_tours\geosoft_datasets. 

For example, if INTREPID is installed in  
C:\Program Files\Intrepid\Intrepid4.5.nnn,  
then you can find the INTREPID format sample data at  
C:\Program Files\Intrepid\Intrepid4.5.nnn\sample_data\ 
guided_tours\intrepid_datasets 

This is the default location for the sample data.  If you have installed INTREPID 
normally, the data resides there. If you have installed INTREPID elsewhere, the 
exercises will work just as well. Just use the appropriate pathnames.

For more information about installing the sample data, see  "Sample datasets—
installing, locating, naming" in INTREPID Guided Tours Introduction (G01)

For a more detailed description of INTREPID datasets, see Introduction to the 
INTREPID database (G20).  For even more detail, see INTREPID database, file and 
data structures (R05).

Location of sample data for CookBooks
Right next to the Guided tours data, is a rich set of more exotic geophysics datasets 
and grids, already prepared for the cookbook training sessions. A casual user might 
also gain some trial and error insights into the capbilities of the software, just by 
testing the Project Manger’s ability to preview and describe the attributes of each of 
the cookbook datasets.
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Should you complete this guided tour?
This guided tour is intended for intermediate level users. Its process is more complex 
than that of an introductory level tour and its instructions are less detailed. If you are 
a beginner or wish only to have a brief overview of INTREPID’s capabilities, you can 
omit this guided tour. Omitting this guided tour will not affect your understanding of 
later tours. Examining time series profiles of your signal is often very helpful, 
especially when you also do before and after comparisons. Similarly, noise and spike 
removal is an important step in processing geophysical data.
Gradiometry
With the advent of support for FTG or full tensor gradiometry data, an intersting 
application is the ability to inspect for correlations of the components with the terrain 
correction signal, and then deciding what terrain denisty to use to minimize the 
correlations. The tool has options for Falcon, FTG, Vector field data and a Quaternion 
or 3D rotations signal. The linear vetorization of a 3D rotation matrix is becoming a 
lot more popular as a result of better instrumentaion systems being deployed upon 
aircraft. Some of the geophysical signal can be ascribed to the wrong field gradient 
components when there are errors in measuring the Roll,Pitch and Yaw of the 
aircraft. The traditional “compensation” process to unscramble the signal using 
figures of merit and a 16 to 18 term polynomial, embedded in a black box, has done 
great service over the past 20 years, but the time has come to face up to the 
requirement for new and more rigourous treatments of the rotational attitude of the 
aircraft during acquisition, and the deconvolution to tensor/vector fields. The tensor 
training course is the best place for detailed material on gradiometry. The enhanced 
cookbook datasets and examples that are next to the guided tours, includes some 
samples for you.
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What you will do
Flowchart Summary
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Steps to follow
Launch the 
Profile Editor

1 Start the Project Manager. Navigate to the directory 
install_path\sample_data 
\guided_tours\intrepid_datasets. Start the Profile Editor.
Choose Profile_Editor from the Editors menu, INTREPID displays the Profile 
Editor tool.

Display a 
profile

2 Open a dataset and display the raw_mag field.
From the File menu choose Load Signal Field. INTREPID displays the Select 
Signal Dataset dialog box. Open the ebagoola_S dataset directory 
install_path\sample_data\guided_tours\intrepid_datasets 
\ebagoola_S. Select raw_mag. Choose OK. INTREPID displays the Apply Signal 
Filter dialog box. Select None then choose OK.

Examine 
profiles of 
other lines

3 Examine the profiles of several lines
Choose Next and Previous to examine the next or previous line. Note the noise 
patterns throughout all profiles and the larger spikes in lines 2742, 2751, 2761 
and 2771 (INTREPID displays the line number at the right of the screen).
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Select line 2742 4 Display the profile of line 2742.
Use the Next, Previous or Goto buttons to display line 2742 if it is not already 
showing.

Display a copy 
of the profile 
with Naudy 
filter

5 Open a second copy of the raw_mag field with a Naudy noise filter applied.
From the File menu choose Load Signal Field. INTREPID displays the Select 
Signal Dataset dialog box. Select raw_mag. Choose OK.
INTREPID displays the Apply Signal Filter dialog box. Select Naudy then choose 
OK.
INTREPID displays the Naudy Filter Parameters dialog box. Set Tolerance to 0.1 
and Wavelength to 5. The units here are 0.1 nT as the spike finder threshold, and 
filter length of 5 data points in a moving window.

Choose OK.
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INTREPID displays the profile showing Naudy noise levels.

Automatic noise removal
Configure 
search options

6 Set the Find options to interpolate edited points.
From the Edit menu choose Find. INTREPID displays the Condition dialog box. 
Select Interpolate from the Action options.
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There are two traces in the Profile Editor window. Select raw_mag – Naudy 
for automatic editing. This means that you will be searching the raw_mag field 
for noise as detected by the Naudy filter. Choose Search Profile. INTREPID 
displays the Select Search Profile dialog box with a list of profiles that are 
currently displayed. Select (click) raw_mag – Naudy.

Choose OK. INTREPID displays the name of the profile against the Search 
Profile button and place a red frame around the profile in the display.
Specify the domain (set of lines) for automatic editing to include line 
2742 only: Choose Select Domain in the Condition dialog box. INTREPID 
displays the Select Search Domain dialog box containing the list of loaded lines. 
Select (click) line 2742. Choose >> to include line 2742 in the domain. INTREPID 
will show it in the Selected lines list. Choose OK in the Select Search Domain 
dialog box. INTREPID will report the selected domain against the Search Domain 
button in the Condition dialog box. Choose Apply in the Condition dialog box. 
INTREPID displays the Confirm Action dialog box for every spike found. You 
have to choose to either edit or ignore each spike. In the top window, the current 
spike has a red box drawn to mark its position in the profile.
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Apply 
automatic 
editing

7 Apply the automatic editing you have specified one by one to the first few instances 
of noise detected by the Naudy filter, then automatically to the rest of the line. 
Ensure that Point is selected from the Apply To options in the Confirm Action 
dialog box. Choose Edit. INTREPID will find and correct the first noise point in 
the line, indicating the next instance of noise with a small red square.

Choose Edit a few times. Each time you choose Edit INTREPID will edit the next 
instance of noise.

Next noise point

Next noise point
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Once you have observed the process working, apply the automatic editing to the 
rest of the line. Select Line from the Apply To options. Choose Edit. INTREPID 
will remove noise from the rest of the line. Observe the effects of the noise removal 
in the top trace, which shows the raw_mag data without noise filter. Observe also 
that the automatic noise removal removed the low-amplitude noise from the data 
but not the larger spikes.

Manual spike removal by interpolating between points on either side
The spikes have yet to be removed from this data. You can remove them manually 
by:
• Moving individual data points to correct the spike or
• Cutting out the spike and interpolating across the gap.
In this guided tour we will use the second option– interpolate across the section of 
a line that contains a spike.

Select line 
section 
containing a 
spike then 
remove the 
spike

8 Define a section of the profile enclosing a spike ready for interpolation.
Select Select Points mouse mode.

Move the mouse pointer to a point on the profile just to the left of the spike. Hold 
down the mouse button and drag to a point just to the right of the spike. A pair of 
blue lines will appear marking the region as you select it.
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When you release the mouse button INTREPID displays red markers on the 
points selected.

To remove the spike, choose Interpolate from the Edit menu.

Further practice and saving your results
Repeat the 
process

9 If you require further practice, repeat the process with the other spikes in line 2742 
and with the noise and spikes in lines 2751, 2761 and/or 2771.

Saving occurs 
at this point

10 Normally you would save your edited Signal field at this stage.
This has been a brief demonstration of Profile Editing. After completing the 
process you would normally save the edited Signal data. Since you have only 
processed a small portion of the data, we recommend that you do not save your 
work. 
Tip: We have provided a solution field, smooth_mag, which contains data with 
noise and spikes removed. The following guided tours, which demonstrate the next 
steps in the survey data refinement process, will use this field rather than 
raw_mag. 

Examining a section where two lines overlap
This section is optional. Go to Examining the results in a grid if you do not wish to 
complete it.

The ends of lines 3012 and 3013 overlap. It is good practice to remove the end of one of 
the lines as part of dataset processing. You can use the Profile Editor to examine the 
profiles of the lines in the overlap area and determine which line to trim.

The overlap area is between fiducial counts 528068 and 528192 in line 3012, and 
between 536052 and 536178 in line 3013.

Examine a line 
overlap region 
containing 
spikes

11 (Optional:) Open the smooth_mag field with no filter. Turn on horizontal axis 
display. View the profiles on lines 3012 and 3013 in the regions described above.
Open smooth_mag as described in Step 2 above, but with no filter.
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Choose HAxis from the Layout menu. This will show the fiducial count as the 
horizontal axis scale. 
Examine lines 3012 and 3013 in the fiducial ranges set out above (Use the Goto 
button). You will notice that there are spikes in this region of line 3013. See 
"Deciding which line to clip in an overlap area" in Editing with the Flight Path 
Editor (G10) for an illustration and further discussion of this problem.

Examining the results in a grid
This section is optional. If you do not wish to create or examine a grid from the results 
of the profile editing process, go to Step 12.

You will create a grid using a Signal field from which noise and spikes have been 
removed and compare it with a grid that contains noise and spikes.

You can specify the input, output and parameters for creating the grid in this stage of 
the guided tour using the job file ch10_1.job. If you wish, start the Gridding tool and 
load the job file as described in "Task specification (job) file short cuts" in INTREPID 
Guided Tours Introduction (G01). Choose Apply. The Gridding tool will create the 
desired grid.

Grid the 
filtered field 
and examine 
the grid

12 (Optional:) Create a grid dataset called smooth_grid1 from the smooth_mag 
field of the ebagoola_S dataset.
Recall the instructions in Creating grids (G07) for creating grid datasets.
(Optional:) Use the Windows Visualisation Tool to compare the grid created from 
a noise-containing Signal field (raw_grid) with a grid created from a Signal field 
from which noise has been removed (smooth_grid) (identical to smooth_grid1 
you created).
Recall the instructions in Visualisation tools(G05) for viewing these datasets. 
Tip: You can launch two copies of the tool, load a different grid into each one and 
place them side by side on the screen for best comparison.
See the first page of this chapter for an illustration of grids produced before and 
after a profile editing session.
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Exit
13 Exit from the Profile Editor without saving any of your editing.

From the File menu choose Quit. INTREPID displays the Save Before Exit dialog 
box.

Choose No. The Profile Editor will exit.

Key points for this guided tour
In this guided tour you have used the Profile Editor to:

• Apply filters and perform range checks on the data;
• Demonstrate automatic filtering that could be performed on an entire dataset;
• Remove a spike by interpolating between points on either side of the spike.
Using the Profile Editor you can also:
• Select and change values of data points by moving them with the mouse;

Frequently Asked Questions
Q : Can I superimpose profiles?
A : Yes, but in separate synchronised windows. You can load as many different fields 
of the dataset as you wish. The Profile Editor enables you to load and display as many 
field profiles as you wish. Each profile displays in a separate window. The Profile 
Editor synchronises all windows so that it always displays the same part of the same 
line in each window.
Q : Can I also examine gradient, rotational and tensor data
A : Yes. INTREPID uses a colour code system to allow you to show before and after 
traces in the same plot using the common scale option.
Q : Can I compare fields with and without noise filters?
A : Yes. You can load several copies of a field and display each copy differently, 
including versions of the data before and after processing.
Q : What filter technology is used?

A : All the filters are 1D convolution operators in this tool.
Library | Help | Top © 2012 Intrepid Geophysics  | Back | 


	Removing noise and spikes with the Profile Editor (G09)
	Overview
	Profile Editing process
	Grids produced from data before and after use of Profile Editor
	Context of this guided tour
	Should you complete this guided tour?

	What you will do
	Flowchart Summary

	Steps to follow
	Key points for this guided tour
	Frequently Asked Questions


